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Where to Find Help When You Need It 
 
Help from your Division/College’s Computer Consultant 
Some divisions and colleges have computer consultants assigned to them.  You can contact these 
consultants when you need help.  To determine if you have a consultant assigned to your division or 
college, look to: http://rohan.sdsu.edu/~facstaff 
 

Help from the BATS Web Page  
BATS (Baseline Access, Training and Support) is a California State University initiative to provide all 
students, faculty, and staff with "baseline" access to information resources via networks, training in the 
uses of baseline hardware and software systems, and ongoing professional and technical support for 
utilization of computer resources at San Diego State University.  You can access the BATS Web Page 
by pointing your browser to: http://rohan.sdsu.edu/~bats/ 
 

Help in the San Diego State University, Faculty Room 
The Faculty Room is staffed Monday through Friday with computing consultants who will try to answer 
your questions.   
Location:    Adams Humanities, 1109 
Phone Number:   x45727 
Semester Hours:   7:30am – 6:00pm Monday -Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 

 
Help from the Faculty Computing Help Line 
Phone Number: x41348  E-mail: helpline@mail.sdsu.edu 
Semester Hours:   7:30am – 6:00pm Monday – Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 

 
Help from the Staff Computing Help Line 
Phone Number: x40824  E-mail: staffhelp@sdsu.edu 
Semester Hours:   7:30am – 6:00pm Monday – Thursday 

7:30am – 4:30pm Friday 
Semester Intersession:  7:30am – 4:30pm Monday – Friday 
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ONSCREEN HELP 
 
 

 
 

Onscreen Help 
 
To view onscreen help, click on Help.  The Help menu will pull down.  
Once the menu is displayed, select one of the following tabs: 
 
Show the Office Assistant 
 
An icon will appear.  Click on icon and a menu will appear. Click on 
subject that you are interested in or type in your question in the blank 
box at the bottom of the menu. Then press the enter key. Hide the Office 
Assistant by clicking on the Assistant icon, the click on the right side of 
the mouse and select hide.  
 
What’s This?  
 
Select this option and your cursor will include a Question Mark next to 
it. Click on anything on the screen and Word will provide an 
explanation of the item. 
 
Help in the User’s Manual 
 
You can also use the User’s manual that came with your software to 
help you answer questions and find solutions to problems. 
 
Help on the Web 
 
Additionally, Microsoft offers Help for “frequently asked questions” at 
their support website located at: 
 
 http://www.microsoft.com/support/ 
 

 
CUSTOMIZING 
EXCEL 
 
 
 
 
 

Customizing Settings 
 
 
 
 
 

One of the strengths of Excel is the ability for each individual user to 
customize the program so that it works the way the user wants it to 
work. 
 
You can customize a variety of Excel settings and you can customize 
the toolbar(s) that appear on your screen. 
 
 
To customize Excel’s settings, click on Tools on the Menu Bar, and 
select Options (Windows) or Preferences (Macintosh). You will be 
presented with a dialog box that contains 8 tabs.  You can change the 
settings for various functions on each of the tabs. 
 
Many of the options should not be changed from the default.  The 
following functions are most often customized to simplify the use of 
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Excel: 
 
View Tab 

If you have a slower computer, you should consider activating the Show 
Placeholders option. This will allow you to scroll quickly through a 
document since objects do not have to be displayed. 
 
If you would always like to see your page breaks on your document, 
activate the Page Breaks option. 
 
Calculation Tab 

If you have a large spreadsheet with a lot of formulas in it, and if you 
notice a delay each time you modify one of the formulas, you should 
consider selecting the Manual option in the Calculation section. 
 
 
With this option selected, Excel will only update your calculations when 
you ask it to do so, instead of recalculating all formulas each time an 
edit is made. When you are ready to recalculate, press the F9 key. 
 
Edit Tab 
One handy option allows you to dictate which cell becomes active when 
you press the Enter key (Windows) or Return key (Macintosh). 
 
By default, when you press the Enter/Return key, the cell below the 
current cell becomes the active cell.  You can choose to make the active 
cell the cell above, below, to the right or to the left of the current cell. 
 
If you deselect the option, the current cell will remain the active cell 
when you press the Enter/Return key. 
 
General Tab 
The Recently Used File List setting determines how many files appear 
at the bottom of the File Menu. You can have up to nine files appear at 
the bottom of the File Menu.  The default is four files. 
 
The Sheets in New Workbook setting determines how many blank 
worksheets are available in a new workbook.  By default, Excel opens 
three blank worksheets in each new workbook.  You can change the 
setting so that up to 255 blank worksheets appear in a new workbook. 
 
The Standard Font setting dictates the type and size of font that will 
default into each new workbook.  You can change the standard font type 
and size to your preferred font. 
 
The Default file location setting tells Excel where to look for files 
when you open an existing document.  If you set this to the folder that 
holds all your data files, you will speed the opening of your documents. 
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CUSTOMIZING 
TOOLBARS 
 
 

 
 
 
 
 

 
Custom Lists Tab 
Here you can create lists that Excel uses when you copy a cell into 
adjacent cells using the AutoFill handle. For example, if you commonly 
create a long list of headings specific to your department, you can create 
a custom list to make this job easier. 
 
You can create custom lists two ways: 
 
1. Click NEW LIST in the Custom Lists window.  Then click in the 

List Entries window and type each list member, pressing the 
Enter key after each entry.  Click the Add button when you are 
done. 

 
 
2. Create a new list by selecting a range of cells in the Import List 

from Cells field.  Once the range of cells that contains the list is 
entered, click the Import button to create the new list. 

 
You can delete buttons that you never use from your toolbars, and you 
can add buttons to simplify your work. 
 
To begin the customization process, click on the Tools option on the 
Menu Bar and choose Customize.  You will be presented with the 
Customize dialog box.  
 
The Toolbars tab lists all the available toolbars.  The toolbars with the 
“checked boxes” indicates the toolbars that are active.  You can activate 
or deactivate a toolbar by selecting or deselecting the toolbar here. 
 
Removing Buttons 
While the Toolbars Tab is visible, you can remove any buttons from 
the active toolbars. To do this, click on the button that you want 
removed and drag the button down and off the toolbar.  When you 
release your mouse button, the unwanted button will be gone. 
 
Adding Buttons 
To add buttons, select the Commands tab.  This tab contains the 
Categories and the Commands windows.  To add a button to a toolbar, 
first select your category.  Within each category is a variety of 
commands.  With the category selected, click on the desired command 
and drag it to the desired toolbar.  When you release the mouse button, 
the new command will be inserted onto the toolbar. 
 

AUDITING 
 

 

Excel offers an easy way to check your worksheets to ensure that your 
formulas are created correctly.  With Excel, you can display tracer lines 
to find precedents (cells that are referred to by a formula), dependents 
(cells that contain formulas that refer to other cells), and errors in any 
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cell. 
 
The first step in the process is to activate the Auditing Toolbar.  You do 
this by clicking on Tools on the Menu Bar, then selecting Auditing and 
finally selecting Show Auditing Toolbar. 
 
Tracing Precedents 
To determine which cells are used in the calculation of a value in 
another cell, select the cell with the calculated value.  Click on the 
Trace Precedents button and Excel will graphically show you which 
cells are used in the calculation of the value in the selected cell.  Click 
the button repeatedly, and Excel will take you deeper into the precedent 
relationship. 

 
 
 
 
Tracing Dependents 
 
To determine which cells depend on the value in a specific cell, select 
the specific cell.  Click on the Trace Dependents button and Excel will 
graphically show you which cells rely on the value in the selected cell.  
Click the button repeatedly, and Excel will take you deeper into the 
dependent relationship. 

 
 
Removing Precedent/Dependent Arrows 
You can remove the arrows one level at a time by using the Remove 
Precedent Arrows button and the Remove Dependent Arrows button. 
 

      
 

You can also click the Remove All Arrows button to remove every 
arrow in the worksheet with one click.   
 

 
 
Tracing Errors 
When cells return an error result, such as #VALUE!, select the cell with 
that result and click the Trace Error button.  The normal trace arrows 
are drawn which enables you to track down the source of the error 



 

Microsoft Excel Intermediate II – Windows and Macintosh  5 

 
 

message. 
 
When you see the following symbol, this means that the trace extends to 
another worksheet or workbook.  When you double click on the symbol 
you will be told which workbook or worksheet has cells involved in the 
trace.  

 
 

 
VALIDATING USER 
INPUT 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 

If you create worksheets that others will use to enter data, you can define 
rules for the data that is to be entered.  If invalid data is entered, you can 
have automatic pop-up reminders and messages display. 
 
Setting Validation Rules 
To set rules, you must first access the Data Validation dialog box. You 
do this by selecting the cells in the worksheet that are going to be subject 
to the rules.  Once the cells are selected, choose Data from the Menu Bar 
and select the Validation option.  The Data Validation dialog box will 
appear.  The box has three tabs.   
 
The Settings Tab 
In the Settings tab, you set the actual rule for the selected cells.  You first 
choose a type of data that can be entered in the Allow text box, and then 
you complete the remaining fields on the Settings tab to set the rules for 
that data type. 
 
A variety of types of data can be selected, as seen below: 
 

 
 
The remaining fields change based on the data type you choose in the 
Allow text box. 
 
The Input Message Tab 
With this tab, you can create input messages that remind the people using 
the worksheet of what data is required. When a cell is selected that has an 
input message defined, a comment appears with the information you type 
in the dialog box.  An example message follows: 
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The Error Alert Tab 
Use this tab to set an error alert for those times when data entered into the 
cell violates the established rules. 
 
Three types of error alerts can be defined: 
 
Information – When displayed, the user can simply acknowledge and 
continue, leaving the invalid data intact. 
 
Warning – When displayed, the user must acknowledge that they want to 
leave the invalid data intact. 
 
Stop – When displayed, the user must correct or reverse the entry. 
 

 
OUTLINING 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

With larger worksheets, it is sometimes hard to get the big picture 
represented by the data.  Sometimes you want to hide some of the data 
and only see totals. 
 
With Excel, you can create different outline levels in your worksheet.  
This way you can hide or reveal the data as needed. 
 
Creating an Outline Level 
To create an outline level: 
 
1. Select the rows or columns to be outlined.  Outlined areas cannot 

be immediately adjacent to other outline areas. 
 
2. Choose Data from the Menu Bar, select Group and Outline, and 

then select Group. 
 
The outline is automatically created. 
 
Using Outlines 
Once an outline is created, you can click on the Show/Hide Detail 
buttons (the plus and minus buttons) to display or hide the contents of the 
outlined region. 
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Removing an Outline Level 
To remove an outline level: 
 
1. Select the rows or columns that make up the outline to be deleted. 
 
2. Choose Data from the Menu Bar, select Group and Outline, and 

then select Ungroup. 
 
The outline is automatically deleted. 
 

 
LINKING TO MS 
WORD 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can take information from an Excel worksheet and place that 
information into a Word document.  This information can be embedded 
in the Word document or linked to the Word document. 
 
Embedded vs Linked Information 
If you embed Excel information into a Word document, a duplicate of 
the Excel information is actually added to the Word document. This can 
dramatically increase the size of the Word file. 
 
In addition, if the information in the Excel document is changed, that 
change will not be reflected in the Word document. 
 
If you link Excel information to a Word document, a pointer is stored in 
the Word document. This pointer references the actual information that is 
in the Excel document.  This method does not dramatically change the 
size of the Word document. 
 
With a link, when the information in Excel is changed, the information 
displayed in the Word document will change to reflect the current Excel 
document. 
 
 
Embedding Information 
To embed Excel information into a Word document: 
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1. Select the desired cells in Excel. 
 
2. Click on Edit on the Menu Bar and select the Copy option. 
 
3. Open the Word document and place the cursor at the location 
 where you want the Excel information inserted. 
 
4. Click on Edit on the Menu Bar and select the Paste option. 
 
5. The information is now embedded in the Word document. 
 
Linking Information 
To link Excel information to a Word document: 
 
1. Select the desired cells in Excel. 
 
2. Click on Edit on the Menu Bar and select the Copy option. 
 
3. Open the Word document and place the cursor at the location 

where you want the Excel information linked. 
 
4. Click on Edit on the Menu Bar and select the Paste Special 

option. 
 
5. In the Paste Special dialog box click on the Paste Link button. 
 
6. Select the Formatted Text (RTF) option 
 
7. Click on OK and the information will be linked to the Word 

document. 
 

 
CONCATENATION 
 
 
 
 
 
 

Join Multiple Cell Values 
into a Single Cell 

You can join the values in two or more cells into a single cell.  For 
instance, if you have a person’s first name in one cell and their last 
name in a second cell, you can concatenate the cells which will result in 
the full name being displayed in a single cell. 
 
 
 
To join multiple values into a single cell: 
 
1. Enter the “=” sign to indicate a formula is being created. 
 
2. Enter the address of the first cell. 
 
3. Enter an ampersand character (&). 
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4. You can insert a space between the two cell values by typing two 

quote marks with a space between them. (“ “) 
 
5. Enter a second ampersand character (&). 
 
6. Enter the address of the second cell. 
 
7. Press the <Enter> key to complete the formula. 
 
 NOTE:  You can concatenate more than two cells by continuing 

to enter the cell names, separated by ampersand characters. 
 

 
 

 
TEXT TO COLUMNS You can take text in a single cell and break it out into multiple cells.  

For instance, if you have a person’s name in a single cell (Firstname, 
Lastname) and you want to sort by Lastname, you can breakup the name 
into separate cells and then you can sort by Lastname. 
 
To split single values into multiple cells: 
 
NOTE:  You must have enough empty cells to the right of the original 

cell to hold the data once it has been split. 
 
1. Select the cell with the multiple values. 
 
2. From the Menu Bar click on Data, then select Text To 

Columns.. . 
 
3. A wizard will start.  The data will either be delimited (characters 

such as commas or tabs separate each value) or fixed width 
(fields are aligned in columns with spaces between each field).  
Select the appropriate option.  Click on Next. 

 
4. If delimited, check the box that contains the appropriate 

delimiter.  If fixed width, insert, delete or move the vertical line 
so that the window shows the breaks as you desire them.  Click 
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on Next. 
 
5. Click Finish and the data will be spread into the appropriate 

number of colums to the right of the original column. 
 

 
AUTO FILTER 
 
 
 
 
 
 
 

Filter a List 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you are working with a list of items as you would if you had a 
database in Excel, you can use the AutoFilter tool to quickly search 
through your list for particular records. 
 
The AutoFilter tool lets you filter out all records that do not meet your 
criteria.  The list itself is unchanged and you can change the filter at any 
time to display a different set of records. 
 
To apply an AutoFilter to a list: 
 
1. Select a column (or multiple columns or cells in your database) 

and select Data from the Menu Bar, select Filter and then click 
on AutoFilter.  Excel will display an arrow button for each 
selected column or group of cells.  These buttons activate pull-
down manus that allow you to show individual records meeting 
your selected criteria. 
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2. To display a filtered list of records, click on one of the buttons 
and select your desired criteria. 

 

 
 
3. You can also select one of the following :special filtering options 
 
ALL - Unfilters your list and shows all records. 
 
TOP 10 – (Used for numbers and dates only)  Displays the top or 
bottom 10 (or another number you select) of records in the list, or the 
top or bottom 10% (or another number you select) of the records in the 
list. 
 

 
 
BLANKS – This selection allows you to display only the records with 
missing entries. 
 
NONBLANKS – This selection allows you to display only records that 
have some type of entry in the cell. 
 
CUSTOM – This option allows you to display criteria meeting your 
customized needs.  State your comparison criteria by selecting the 
desired operator then enter the comparison value in the window on the 
right. 
 
 
 

 Windows and 
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You can use multiple comparison criteria by selecting the AND or OR 
options and entering the desired criteria in the lower two windows. 
 
 

 
 

 


